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The material in this information packet is for educational purposes only and not to be construed as 
legal advice about what you should or should not do.  The information herein is to assist you in 
performing your own due diligence before implementing any strategy.  By using this material, you are 
agreeing that no particular result is guaranteed or implied. 

 

Some conventions used in this document: 

Throughout this file, you will see information presented in two different fonts and colors.  
Instruction pages will use the Arial (san serif/without curves) font and navy blue as the color 
(this page uses this font and color).  The information on the instruction pages will be 
educational in nature and, most of the time, will contain instructions to follow or tasks to 
perform.  

Instructions will generally not be mixed with the document pages; but, if it is necessary to mix 
them, the font and text color conventions will be followed.  So, if there are instructions 
imbedded in a document page or highlighted text, you will need to delete the instructions and 
remove the highlighting before printing the final version of the document page. 

Document (contacts, affidavits, etc) pages use Times Roman (serif/with curves) font and in black 

ink.  You will customize the document pages and then do something with them, such as mail or 
record them.   

Please “Print Preview” your documents before you print them.  This is especially important if 
you have substantial personal information you have added to a document, such as many other 
names.  Also, some printers will not let you print closer to the margin than .55 inches.  Feel 
free to adjust the margins if your printer will not accommodate the current spacing.  

Discharge Debt: 

We suggest you be extremely judicious in the use of BOE’s and only use a BOE if it is in 
conjunction with a Conditional Acceptance/Affidavit where the “creditor” must prove their 
claims before negotiating the BOE.  We are working on strategies to deal with “creditors” who 
act as if your BOE is no good.  As we gain further experience in these areas, we will make 
additional information available.  The following is provided for your education. 

The purpose of this file is to create documents (Bill of Exchange, Letter of Advice, etc.) that 
can be used to discharge debts.  A Bill of Exchange (BOE) cannot be used to buy an item (car, 
house, stereo system, big screen TV, etc.).  A BOE can only be used to discharge pre-existing 
debts.  At this point, we believe that some sort of “loan” would have to exist or credit used to 
purchase the item and then a BOE can be used to discharge the “loan”.  We say “discharge” 
rather than “pay” a debt because, since 1933, we have only had the ability to “discharge” a 
debt.  The basis of all “money” in circulation in America, since 1993, has been a Federal 
Reserve Note.  A “note” is a debt instrument, a promise to pay.  Common sense tells you that 
you can’t pay a debt with a debt (a Federal Reserve Note, or any other promise to pay).  The 
foundation of our ability to discharge a debt using a BOE is House Joint Resolution 192 of 
June 5, 1993.  If you are not familiar with this legislation, you should study it thoroughly. 



How “creditors” respond to BOEs: 

The most frequent question in the mind of anyone who wants to use a BOE is how will the 
“creditors” respond.  First we should say that we don’t know of a single instance in which 
anyone has gone to prison for issuing a properly executed BOE.  But we must also say that, in 
many cases, “creditors” pretend they don’t know what a BOE is or are not going to like 
receiving your BOE and will likely accept your BOE and pretend they didn’t receive it, not 
processing them or act dishonorably.  

Before elaborating on this point, let’s explain why use the term “creditors” in quotes.  We 
believe that we, as living souls, are ultimately the source of all credit.  This being the case, “We 
the People” are the ultimate creditors and those whom we have called “creditors” in the past 
are really just fictional organizations (“persons” created by the government) to whom we issue 
some our credit. 

We’ve said that the “creditor”, in most cases, won’t like your BOE.  This is because they have 
been accustomed to receiving a lot of interest and principal payments on “loans” they made to 
us by lending us our own credit.  Said another way, they have pretended to “loan” us money, 
then ask us to pay back the principal with interest when, in fact, they loaned us nothing from 
their own assets.  When we use the BOE to discharge the purported debt, we cut off their 
supply of all the profits that they think they deserve.  

At this stage in the use of BOEs, it is hard to predict exactly how a “creditor” will respond.  But 
you need to be prepared for the possibility that they will act as if you have never “paid” them.  If 
you are discharging credit card debt, they may close or cancel the account, turn your account 
over to a collection agency, and put negative information on your credit report.  None of this 
means that your BOE was invalid, illegal or fraudulent.  It just means they don’t like it. 

Your first and most important decision will be to answer this question within yourself, “Did my 
BOE really discharge the debt?”.  When you can answer this in the affirmative, then you will 
have taken a major step.  We would also suggest that the answer should be “yes”.  Let’s use 
an example to illustrate this point.   

Let’s say you owed someone $100 and that you sent them $100 to discharge the debt.  But 
then they acted as if the debt was still owed.  In this case, was the debt discharged?  
Assuming they received the “money”, then the answer should be yes!  The only question 
remaining in your mind should be, “Is the BOE a good instrument?”  If you aren’t comfortable 
that is not only good but also valid, then you should not use a BOE. 

At this stage, we would suggest only using BOEs on unsecured debt, such as credit cards.  
And we recommend you issue BOEs in conjunction with a Conditional Acceptance/Affidavit 
where they must prove their claims before negotiating the BOE through a notarial protest (ask 
us about the Honor-Dishonor Program).  If you were to try to use a BOE on a secured debt, 
like a car, the creditor may very well have someone repossess (steal) the car.  So, be cautious 
as you decide if you will use BOEs and on what type of debts. 

We are working on strategies to deal with “creditors” who act as if your BOE is no good.  As we 
gain further experience in these areas, we will make additional information available. 

“Creditors” who don’t accept/recognize BOEs: 

It is quite possible that the creditor will continue to send you presentments that reflect that the 
BOE payment was never posted.  It is also possible that they will either not answer your Notice 



of Error or will not provide adequate “proof” for their position.  

If either of these things occurs, you will need to take some additional steps.  We suggest the 
following steps:  First step, send the creditor a Conditional Acceptance/Affidavit.  If the creditor 
does not respond to this appropriately, you will need to do the second step:  Notarial Protest.  
These two steps are bundled in a Notarial Protest product.   Ask the person who told you about 
the redemption information to give you further information.  The Notarial Protest will result in a 
Certificate of Dishonor against the creditor. The Certificate of Dishonor can be used to help 
clear any negative information the creditor puts on your credit report and may be used in court 
proceedings.  We will be looking for a credit repair service to assist with these steps. 

Throughout the rest of this file, the beginning of each step will start with instructions which will 
be proceeded with a letter for the step.  The step will be identified with large bold red text 
giving the step name and letter. 

a. Gathering materials 

Obtain the following USPS  forms:  

 two PS Form 3800 (Certified Mail Receipt) 

 two PS Form 3811 (Domestic Return Receipt, green card).  

 9 x 12 envelopes with address labels (You can use USPS Priority envelopes, but they 
cost more) 

You  need two each of these forms for each BOE you issue.  It is always advisable to have 
extra sets of these forms so you don’t have to go to the Post Office very time you send a Bill of 
Exchange (BOE). 

b. Replace tags with your data – one time 

The BOE documents contain a number of variables (called “tags”) that act as place holders for 
your personal data.  The table below shows a list of all of these tags. The first column explains 
what the data should be, the second is the strings that will be replaced (the tag) and the last 
column is a sample of what the data might look like that you will replace the tag.  You will be 
replacing all of the tags for the entire redemption process as you follow the steps below. 

Before you begin your customizing work, save a copy of this file now under a different file 
name.  You will do this using the “Save as” option under the “File” menu; i.e., you might insert 
your last name or the creditor’s name and the date when the file was created somewhere in 
the file name, e.g. Smith-VISA-BOE-2003-07-21.doc. 

You will use the “Replace” facility in MS Word to search for and replace each of the strings in 
the “Replacement String” column shown below.  The “Replace” menu item can be found under 
the “Edit” menu.  When you select “Replace” a dialog box will open that contains a line labeled 
“Find what:” where you will enter the string you want to replace.  The dialog box also contains 
a “Replace with:” line where you will enter the placement string.  

For example, if you want to replace the “<ssn>” tag, you would enter “<ssn>” in the “Find 
what:” line and type your SSN on the “Replace with:” line.  Then, you would click the “Replace 
All” button.  Repeat this process for each tag in the list. 

To make sure that you have not missed any tags, scroll to the top of this file and perform a 
search operation for “<”.  The “Find” menu item is under the “Edit” menu.  If you aren’t able to 
locate any tags, then you have successfully replaced all tags. 



Once this is completed, save the file again under the new name to make sure you don’t lose all 
your work. 
 

Description Replacement string Sample data 
True Name - your current full 
legal name with upper & lower 
case letters 

George Mosley, Jr John Quincy Public 

Bond number from the back of 
your Social Security card (will 
contain a letter, A-N, and 8 digits) 

E55020304 E81726354 

Your mail address  General Post-Office                                               
Sarasota, Florida [34236-9998] 
 

100 Maple Ave. 
Dallas, Texas [75000] 

The state where you reside and 
recorded your copyright notice. 

Georgia Texas 

Your straw man name which is 
your full name in all capital letters 

GEORGE MOSLEY, JR JOHN Q. PUBLIC 

Social Security Number 222-28-8693 123-45-6789 

Employer/Exemption 
Identification Number; your SSN 
without the dashes 

222288693 123456789 

Certified mail number you used 
to set up your UCC Contract 
Trust account with the Secretary 
of the Treasury 

<ucc-contract-num> 7001 2510 0001 3000 0400 

 
 

c. Create an Accepted for Value stamp 

Create an “Accepted for Value” stamp. This stamp will be used for many Bills of Exchange. 
You will probably only need to create the stamp once rather than for each BOE that you issue.  
The stamp should read as follows: 

Non-Negotiable Non-Transferable Charge Back 

Office Holder - Secretary of the Treasury 

I accept for value all related endorsements in accordance with 

UCC 3-419, HJR 192 and Public Law 73-10. Charge my  

Private UCC Contract Trust Account Employer Identification # <ein> 

for the registration fees and command the memory of account # 

<ein> to charge the same to the Debtor’s Order, or your Order. 

Employer Identification # <ein> – Bond # <bond-num> 

Pre-Paid – Preferred Stock – Priority  

Exempt from Levy – Posted: Certified Account 

Invoice #___________________ Date __________ 

________________________________________  

Be sure you sign on the last blank line. 

We suggest that using transparency film on your computer printer (some film is designed for 
laser printers and other film is designed for ink jet printers).  When you make the stamp, 
substitute <ein> for your Social Security Number without the dashes.  Substitute the <bond-
num> for the bond number found on the back of your Social Security card (it is one letter 



followed by eight digits). The invoice number is one you will assign to each document where 
you use the stamp. You might consider using a combination of your initials and the date, e.g. 
JQP20030416.  

d. Replace tags with your data – for each BOE 

In this step, begin with the file that you created in the previous editing step.  For example, if, in 
the last step you created a file named Smith-BOE-template-2003-07-21.doc, then this would 
be the file you should now open. 

The table below is a list of tags that must be changed for each BOE you issue.  Use the same 
procedure as the instructions above to replace these tags.  

To make sure that you have not missed any tags, scroll to the top of this file and perform a 
search operation for “<” using the “Find” menu item is under the “Edit” menu.  If you aren’t able 
to locate any tags, then you have successfully replaced all tags. 

Once you replace all these tags, save a copy of the file under another new name.  The name 
of the file could reflect the name of the “creditor” to whom you are issuing the BOE and the 
date your are issuing the BOE.  For example, if you were issuing a BOE to Bank Of America, 
you could name BOE-BankOfAmerica-2003-07-01.doc. 

Proceed to the next instruction page. 
 

Description Replacement string Sample data 
The name on your account with 
the “creditor”, usually in upper 
case 

<account-name> JOHN Q PUBLIC 

The date your are going to issue 
the BOE, usually the current date 

<current-date> May 15, 2003 

The amount of debt you are 
terminating in numbers 

<discharge-amt> 9,526.00 

The amount of debt you are 
terminating in words 

<discharge-amt-text> Nine Thousand Five Hundred 
Twenty-six dollars and no cents 

The number of the BOE, same 
number as certified mail 
certificate used to mail BOE to 
the creditor 

<BOE-num> 7001 2510 0001 3000 0400 

The name of the “creditor” whom 
you owe  

<creditor-name> ABC VISA SERVICES 

The address of the “creditor” 
whom you owe 

<creditor-street> 
<creditor-city-st-zip> 

1500 East Ave 
Simi Valley, CA 93065 

The account number you have 
with the “creditor” 

<creditor-acct-num> 9876 5432 1098 7654 

The invoice number you assign 
to the creditor’s invoice when you 
apply the Accepted for Value 
stamp. Usually your initials with 
the current date in YYYYMMDD 
format 

<invoice-num> JQP20030515 

The name of the friend who will 
make the BOE packets 

<friend-name> Mary Jones 

The address of the friend who 
will make the BOE packets 

<friend-name> 

<friend-city-st-zip> 

c/o 101 Elm Ave. 
Dallas, Texas [75000 

 



d. Prepare charging instrument 

The event that actually starts the issuing of a BOE is when a “creditor” sends you a 
presentment or charging instrument, usually a bill.  It is very important that the charging 
instrument contain an amount that is due.  You cannot issue a BOE unless you know the 
amount so that you can exchange it. 

Prepare the charging instrument (the bill from the creditor).  You are going to put the Accepted 
for Value on the charging instrument (the stamp you should have already created).  Position 
the stamp in such a way that it does not obscure any of the significant writing on the 
instrument.  You want to apply the stamp to the original version of the presentment.  The best 
way is to print onto the face of the charging instrument by running the charging instrument as 
the source page through your printer.   

Now, date and sign the charging instrument in blue ink, and write in your EIN (your SSN 
without the dashes) and fill in the amount.  When you have completed this step, the charging 
instrument has now been accepted for value.  Make two copies:  One for your records and one 
to send to the Secretary of the Treasury.  On the copy for the Secretary, print in red ink 
“COPY”. 

 

e. Printing the original BOE & Letter of Advice 

The next two pages contain the BOE and the Letter of Advice.  Print a single copy of each of 
these two pages.   

This file contains many section breaks.  Your version of MS Word may not support printing a 
page range when the document contains page breaks.  If this is the case, when you attempt to 
print a page range, the entire document will be printed.  The way around this is to put the 
cursor on a specific page and the print just the “current page” which is one of the options in the 
dialog that is displayed when you select the “Print” menu item in the “File” menu. 

Once the documents are printed, sign each page using blue ink using your normal signature. 

 
 



$<discharge-amt> $<discharge-amt> 
BONDED BILL OF EXCHANGE ORDER 

Bill of Acceptance – Time Draft - #<BOE-num> 

NOT A SECURITY – NOT FOR DISCHARGE OF PUBLIC DEBT 

<true-name>, Secured Party—Drawer Date: <current-date> 

c/o <mail-street> 

<mail-city-st-zip> 

 

To:   Secretary of the Treasury, Department of the Treasury Bank – ABA Ledger #000000518 

No later than 15 days after receipt, please Credit the account for <account-name> at <creditor-name> 

 

<discharge-amt-text>  --------------------------------------------------------- $<discharge-amt> 

 

Personal Treasury UCC Contract Trust Account # <ucc-contract-num> 

 

The obligation of the Drawee (acceptor), Secretary of the Treasury, through the bailee (authorized agent) of 

Claimant’s financial institution, TTL Department, hereof arises out of the want of consideration for the pledge 

and by the redemption of the pledge under Public Resolution HJR-192, Public Law 73-10 and Guaranty Trust Co. 

of NY v. Henwood et al, 307 U.S. 247 (FN3), represented by the attached claim Accepted for Value and bearing 

the account number # <creditor-acct-num>. 

 

This claim document Order complies with UCC 3-104, the terms of the original contract, hereby surrendered as 

said pledge is redeemed (discharged) by the drawer through the attached document by acceptance for value and 

exempted from levy.  Federal regulations require Claimant’s financial institution to accept this bill, sign and 

present directly via Certified or Registered mail, Return Receipt to the Secretary of the Treasury — Department of 

the Treasury on Drawer’s UCC Contract Trust Account.  Unless the original Negotiable Instrument is dishonored 

in writing within 15 days of receipt by the Secretary of the Treasury Claimant’s financial institution is to release 

the credit on hold to the payee (Claimant) within the time stipulated by Regulation “Z”, Truth in Lending Act or 

on the date designated, whichever is later.  The amount of this accepted draft is to be ledgered by Claimant’s 

financial institution, TTL Department, to the designated account for the discharge of this claim (Regulation Z).   

Bond # <bond-num> These are Certified Funds. 

NOTICE:  The law relating to principal and agent applies. 

 

by ______________________________________________ 
       Bailee’s signature (authorized bank TTL agent) w/o prejudice 

 

Accepted at __________________________ (city), _______________ (state) on __________ (date) 

Document Copies filed with the DTB 

 _____________________________________ 
 Drawer, Secured Party-Creditor; Without Recourse 

To be processed as a check – Do not present for collection 

$<discharge-amt>Bonded Negotiable Instrument - Void Where Prohibited By Law.$<discharge-amt> 
 



—LETTER OF ADVICE— 

IMPORTANT BANK AND TREASURY ROUTING INSTRUCTIONS—REQUIRES SPECIAL HANDLING 

NOT TO BE PRESENTED FOR COLLECTION - PROCESS AS A CHECK 

Promptly mail via Certified Mail, Return Receipt, the signed instrument with these documents to: 

Mr. John W. Snow, or his successor – The Secretary of the Treasury – Department of the Treasury,  

1500 Pennsylvania Ave NW, Washington, D.C. 20220 
 

<creditor-name> <true-name>, Secured Party—Creditor 

<creditor-street> <mail-street> 

<creditor-city-st-zip> <mail-city-st-zip> 

Re: Notice – Processing of Bill of Exchange (BA -Time Draft) Date: <current-date> 

I am in receipt of the attached offer requesting payment.  Please find attached the Bill of Exchange (BA – TD), the processing of 

which will discharge the entire current amount stated on the claim herein accepted for value.  This attached Negotiable Instrument is 

presented under authority of HJR-192, Public Law 73-10, UCC 3-104(c), Spencer v. Sterling Bank, 63 Cal Ap. 4
th

 1055 (1998), 

Guaranty Trust Co. of New York v. Henwood et al, 307 U.S. 247 (FN3), and Witkin Negotiable Instruments, Vol. III (including 2002 

Supplement) on the undersigned’s UCC Contract Trust Account.  Following are the steps required by Regulation to settle this 

account. 

This is not a Treasury Security, nor involving a Treasury/Direct Bond Account, nor is this instrument to be processed through the 

Bureau of Public Debt, nor is this instrument to be applied toward the national debt.  These are Certified Funds. 

1. The attached Negotiable Instrument is in accordance with UCC 3-104 and complies with the terms of the original contract.  The 

following process must be followed to the letter in order to satisfy the claimed amount due on this account and discharge of this 

debt. 

2. My Personal UCC Contract Trust Account has been established with the Department of the Treasury and may only be accessed 

with my approval through the bank account of the Claimant directly to the Secretary of the Treasury (Drawee).  

3. The original Negotiable Instrument is certified and must be presented by claimant’s financial institution, TTL Department, via 

Certified or Registered Mail, Return Receipt, directly to Mr. John W. Snow, the Secretary of the Treasury, or his Successor, 

Department of the Treasury, 1500 Pennsylvania Ave NW, Washington, D.C. 20220,  

4. The Item Processor at Claimant’s financial institution, with full identification and Bailee (Authorized TTL Agent) signature, is to 

present the original Negotiable Instrument along with this Instruction Notice and the stamped Claim to the Secretary of the 

Treasury—Department of the Treasury at the above address.   

5. Claimant’s financial institution is to put a hold on Claimant’s deposit, retain the document copies and await the Return Receipt 

Card from the Federal Window, noting the date the original Negotiable Instrument was received at the Federal Window in 

accordance with Public and Banking Policy.  For out of state transactions, the UCC and Banking Regulations stipulate fifteen (15) 

days. 

6. The copy of the Negotiable Instrument is to be held at the financial institution until the required period for the Federal Window, 

Regulation J and Federal Reserve, Reg. Z-Truth in Lending, 12 USC 226.1 et. seq., the Order/Property has passed.  On the 16
th

 

day, the full-face amount of the Negotiable Instrument is to be released by the local financial institution’s TTL Department and 

credit the Claimant’s account for discharge of the claim.  

7. To ensure that Claimant’s financial institution receives full credit to their TTL account, Claimant’s financial institution is to take 

the retained copies of this Letter of Advice, the copy of the original claim accepted for value, the copy of the original Bill of 

Exchange and enclose these documents with the institution’s next remittance of estimated taxes to the Internal Revenue Service.  

Before enclosing these documents with the remittance, the institution’s Bailee (Authorized TTL Agent) must endorse the copy of 

the original Bill of Exchange on the top reverse side of the instrument.   

8. If the Secretary of the Treasury (Drawee) sends notice in writing of some error or problem, please notify the undersigned 

immediately upon receipt of such Notice and the matter will be addressed.  You will be notified of the corrective action taken.  I 

hereby request that you notify the undersigned when the required time period for the Federal Window and the Federal Reserve 

under Regulation J and Z have transpired, the ledgering completed and the account adjusted by Claimant’s bank. 

Thank you for your cooperation in getting this account settled and the claim discharged. 

 

 
  

<true-name> Secured Party—Creditor 

 

-Not subject to negotiability-



 

e. Customize & printing the Statement of Account 

The next page contains a Statement of Account.  Make the following changes to this 
document: 

 Replace the tag that says “<date 14 days current or mail date>” with a date that 
is 14 days after the day the BOE is going to be mailed.  Do not count Sundays or 
holidays.  Check with the person who is complete the Certificate of Mailing for 
you to ensure their availability on the day you choose. Remove the yellow 
highlighting once you have replaced the string. 

 Replace the tag that says “<your state statute that corresponds to UCC 9-201>” 
with the parallel statute in your state for UCC (Uniform Commercial Code) 9-201. 

Check the internet to look up your state equivalent for UCC 9-201.  The naming 
conventions of most states correspond with the UCC; i.e., the Arizona equivalent  
is 47-9201.  http://www.law.cornell.edu/uniform/ucc.html, may have a link to the UCC 
statutes for you state.  The reason you want to list your state statute is because 
there is really no such thing as UCC 9-201 or any other section reference.  The 
UCC is implemented into the statutes of each state.  In order for a reference to 
be legally valid, you must to include the statute in your state. Remove the yellow 
highlighting once you have replaced the string. 

Print three copies of the Statement of Account once the modifications have been 
completed.  

This file contains many section breaks.  Your version of MS Word may not support 
printing a page range when the document contains page breaks.  If this is the case, 
when you attempt to print a page range, the entire document will be printed.  The way 
around this is to put the cursor on a specific page and the print just the “current page” 
which is one of the options in the dialog that is displayed when you select the “Print” 
menu item in the “File” menu. 

Sign one of the printed Statements of Account in blue ink using your normal signature.  
This will be the original copy.  On the signature line of the other two copies, you can 
print COPY, preferably in red ink. 
 

http://www.law.cornell.edu/uniform/ucc.html


 

<strawman>© 

<mail-street> 

<mail-city-st-zip> 

<current-date> 
 

<creditor-name><creditor-street> 

<creditor-city-st-zip> 
 

Re: Account #<creditor-acct-num> 
 

 

Statement of Account 
 

Balance of Charges on <invoice-num> $<discharge-amt> 

 

Discharge through Bonded Bill of Exchange Order - <discharge-amt> 
 

Ending Balance of Charges: 0.00 
 

 

The balance shown above reflects my good faith Statement of Account for the account indicated 
above.  The Account Representative or his designee may correct or approve the statement.  If 

you determine the balance is different than as shown above, your documented correction must be 
returned to me within two weeks, no later than <date 14 days current or mail date>.  Pursuant to 
<your state statute that corresponds to UCC 9-210> and UCC 9-210, failure to correct and return 

this Statement of Account with supporting documentation of indebtedness within two weeks 
constitutes your agreement with this accounting, after which you and your agents, assigns and 
successors may only make a claim up to the amount this statement shows as a balance. 

 
 

<strawman>©  

By ________________________________ 

<true-name>, Secured Party 

 



 

f. Printing the BOE & Letter of Advice copies 

The next two pages contain the copies of the BOE and the Letter of Advice.  Print two 
copies of each of these two pages.  This file contains many section breaks.  Your 
version of MS Word may not support printing a page range when the document contains 
page breaks.  If this is the case, when you attempt to print a page range, the entire 
document will be printed.  The way around this is to put the cursor on a specific page 
and the print just the “current page” which is one of the options in the dialog that is 
displayed when you select the “Print” menu item in the “File” menu.



 

$<discharge-amt> $<discharge-amt> 
BONDED BILL OF EXCHANGE ORDER 

Bill of Acceptance – Time Draft - #<BOE-num> 

NOT A SECURITY – NOT FOR DISCHARGE OF PUBLIC DEBT 

<true-name>, Secured Party—Drawer Date: <current-date> 

c/o <mail-street> 

<mail-city-st-zip> 

 

To:   Secretary of the Treasury, Department of the Treasury Bank – ABA Ledger #000000518 

No later than 15 days after receipt, please Credit the account for <account-name> at <creditor-name> 

 

<discharge-amt-text>  --------------------------------------------------------- $<discharge-amt> 

 

Personal Treasury UCC Contract Trust Account # <ucc-contract-num> 

 

The obligation of the Drawee (acceptor), Secretary of the Treasury, through the bailee (authorized agent) of 

Claimant’s financial institution, TTL Department, hereof arises out of the want of consideration for the pledge 

and by the redemption of the pledge under Public Resolution HJR-192, Public Law 73-10 and Guaranty Trust Co. 

of NY v. Henwood et al, 307 U.S. 247 (FN3), represented by the attached claim Accepted for Value and bearing 

the account number # <creditor-acct-num>. 

 

This claim document Order complies with UCC 3-104, the terms of the original contract, hereby surrendered as 

said pledge is redeemed (discharged) by the drawer through the attached document by acceptance for value and 

exempted from levy.  Federal regulations require Claimant’s financial institution to accept this bill, sign and 

present directly via Certified or Registered mail, Return Receipt to the Secretary of the Treasury — Department of 

the Treasury on Drawer’s UCC Contract Trust Account.  Unless the original Negotiable Instrument is dishonored 

in writing within 15 days of receipt by the Secretary of the Treasury Claimant’s financial institution is to release 

the credit on hold to the payee (Claimant) within the time stipulated by Regulation “Z”, Truth in Lending Act or 

on the date designated, whichever is later.  The amount of this accepted draft is to be ledgered by Claimant’s 

financial institution, TTL Department, to the designated account for the discharge of this claim (Regulation Z).   

Bond # <bond-num> These are Certified Funds. 

NOTICE:  The law relating to principal and agent applies. 

 

by ______________________________________________ 
       Bailee’s signature (authorized bank TTL agent) w/o prejudice 

 

Accepted at __________________________ (city), _______________ (state) on __________ (date) 

Document Copies filed with the DTB 

 _____________________________________ 
 Drawer, Secured Party-Creditor; Without Recourse 

To be processed as a check – Do not present for collection 

$<discharge-amt>Bonded Negotiable Instrument - Void Where Prohibited By Law.$<discharge-amt> 
 

COPY 

COPY 



 

—LETTER OF ADVICE— 

IMPORTANT BANK AND TREASURY ROUTING INSTRUCTIONS—REQUIRES SPECIAL HANDLING 

NOT TO BE PRESENTED FOR COLLECTION - PROCESS AS A CHECK 

Promptly mail via Certified Mail, Return Receipt, the signed instrument with these documents to: 

Mr. John W. Snow, or his successor – The Secretary of the Treasury – Department of the Treasury,  

1500 Pennsylvania Ave NW, Washington, D.C. 20220 
 

<creditor-name> <true-name>, Secured Party—Creditor 

<creditor-street> <mail-street> 

<creditor-city-st-zip> <mail-city-st-zip> 

Re: Notice – Processing of Bill of Exchange (BA -Time Draft) Date: <current-date> 

I am in receipt of the attached offer requesting payment.  Please find attached the Bill of Exchange (BA – TD), the processing of 

which will discharge the entire current amount stated on the claim herein accepted for value.  This attached Negotiable Instrument is 

presented under authority of HJR-192, Public Law 73-10, UCC 3-104(c), Spencer v. Sterling Bank, 63 Cal Ap. 4
th

 1055 (1998), 

Guaranty Trust Co. of New York v. Henwood et al, 307 U.S. 247 (FN3), and Witkin Negotiable Instruments, Vol. III (including 2002 

Supplement) on the undersigned’s UCC Contract Trust Account.  Following are the steps required by Regulation to settle this 

account. 

This is not a Treasury Security, nor involving a Treasury/Direct Bond Account, nor is this instrument to be processed through the 

Bureau of Public Debt, nor is this instrument to be applied toward the national debt.  These are Certified Funds. 

1. The attached Negotiable Instrument is in accordance with UCC 3-104 and complies with the terms of the original contract.  The 

following process must be followed to the letter in order to satisfy the claimed amount due on this account and discharge of this 

debt. 

2. My Personal UCC Contract Trust Account has been established with the Department of the Treasury and may only be accessed 

with my approval through the bank account of the Claimant directly to the Secretary of the Treasury (Drawee).  

3. The original Negotiable Instrument is certified and must be presented by claimant’s financial institution, TTL Department, via 

Certified or Registered Mail, Return Receipt, directly to Mr. John W. Snow, the Secretary of the Treasury, or his Successor, 

Department of the Treasury, 1500 Pennsylvania Ave NW, Washington, D.C. 20220,  

4. The Item Processor at Claimant’s financial institution, with full identification and Bailee (Authorized TTL Agent) signature, is to 

present the original Negotiable Instrument along with this Instruction Notice and the stamped Claim to the Secretary of the 

Treasury—Department of the Treasury at the above address.   

5. Claimant’s financial institution is to put a hold on Claimant’s deposit, retain the document copies and await the Return Receipt 

Card from the Federal Window, noting the date the original Negotiable Instrument was received at the Federal Window in 

accordance with Public and Banking Policy.  For out of state transactions, the UCC and Banking Regulations stipulate fifteen (15) 

days. 

6. The copy of the Negotiable Instrument is to be held at the financial institution until the required period for the Federal Window, 

Regulation J and Federal Reserve, Reg. Z-Truth in Lending, 12 USC 226.1 et. seq., the Order/Property has passed.  On the 16
th

 

day, the full-face amount of the Negotiable Instrument is to be released by the local financial institution’s TTL Department and 

credit the Claimant’s account for discharge of the claim.  

7. To ensure that Claimant’s financial institution receives full credit to their TTL account, Claimant’s financial institution is to take 

the retained copies of this Letter of Advice, the copy of the original claim accepted for value, the copy of the original Bill of 

Exchange and enclose these documents with the institution’s next remittance of estimated taxes to the Internal Revenue Service.  

Before enclosing these documents with the remittance, the institution’s Bailee (Authorized TTL Agent) must endorse the copy of 

the original Bill of Exchange on the top reverse side of the instrument.   

8. If the Secretary of the Treasury (Drawee) sends notice in writing of some error or problem, please notify the undersigned 

immediately upon receipt of such Notice and the matter will be addressed.  You will be notified of the corrective action taken.  I 

hereby request that you notify the undersigned when the required time period for the Federal Window and the Federal Reserve 

under Regulation J and Z have transpired, the ledgering completed and the account adjusted by Claimant’s bank. 

Thank you for your cooperation in getting this account settled and the claim discharged. 

 

 

  

<true-name> Secured Party—Creditor 

 

-Not subject to negotiability-

COPY 



 

f. Printing the Certificate of Service 

The next two pages contain the Certificates of Service.  

 Print two of the first page (the one with COPY on it).  

 Print one of the original Certificate of Service (the one with your friends’ name 
and address on it).  

This file contains many section breaks.  Your version of MS Word may not support 
printing a page range when the document contains page breaks.  If this is the case, 
when you attempt to print a page range, the entire document will be printed.  The way 
around this is to put the cursor on a specific page and the print just the “current page” 
which is one of the options in the dialog that is displayed when you select the “Print” 
menu item in the “File” menu. 

 



 

CERTIFICATE OF SERVICE 
 

 

On _____________________, on behalf of <true–name>, I mailed to: 

 

<creditor-name>.  

<creditor-street>  

<creditor-city-st-zip>  

 

the papers identified as: 

 

1. Bonded Bill of Exchange # <BOE-num> 

2. Letter of Advice 

3. Invoice <invoice-num> 

4. Statement of Account 

5. Copy of Certificate of Service 

 

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing 

Certified Mail # <BOE-num> for <true-name>, and obtaining a receipt from the Post Office 

clerk. 

 

My mailing location is: 

  

  

  

 

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.  

 

 

Dated ________________________ 

 

___________________________________ _________________________________ 

Printed Name Signature 

COPY 



 

CERTIFICATE OF SERVICE 
 

 

On ___________________________, on behalf of <true–name>, I mailed to: 

 

<creditor-name>.  

<creditor-street>  

<creditor-city-st-zip>  

 

the papers identified as: 

 

1. Bonded Bill of Exchange # <BOE-num> 

2. Letter of Advice 

3. Invoice <invoice-num> 

4. Statement of Account 

5. Copy of Certificate of Service 

 

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing 

Certified Mail # <BOE-num> for <true-name>, and obtaining a receipt from the Post Office 

clerk. 

 

My mailing location is: 

<friend-name> 

<friend-street> 

<friend-city-st-zip> 

 

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.  

 

 

Dated _____________________________ 

 

___________________________________ _________________________________ 

Printed Name Signature



 

g. Assembling & mailing packets 

Prepare the packet to send to the Creditor: 

 Address and fill out PS Forms 3800 and 3811 to mail a packet to the creditor.  

 Affix the Form 3800 certified number strip to the Form 3811.  Place clear tape over 
the number strip. 

 Address a 9” x 12” envelope to the creditor.   

 Affix the Form 3800 receipt to the 9” x 12” envelope to the top of the envelope (at 
least four inches from the right-hand edge). 

 In the upper, left corner, staple together the signed original documents to the 
Creditor in the following order: 

o BOE 
o Letter of Advice 
o charging instrument with the Accepted for Value stamp.  

 Behind the stapled originals, place: 

o A blank Certificate of Service (one with COPY on it) 
o The original signed Statement of Account letter. 

 Put the document set in the envelope to the creditor but do NOT seal the envelop 
yet. 

Prepare the packet to send to the Secretary of the Treasury: 

 Address and fill out PS Forms 3800 and 3811 to the Secretary of the Treasury (address 
on the Letter of Advice).  

 Affix the Form 3800 certified number strip to the Form 3811.  Place clear tape over the 
number strip. 

 Address a 9” x 12” envelope to the Secretary. 

 Affix the Form 3800 receipt to the 9” x 12” envelope at the top of the envelope (at least 
four inches from the right-hand edge). 

 In the upper, left corner, staple together the following documents for the Secretary: 

o COPY of the BOE 
o COPY of the Letter of Advice 
o COPY of the charging instrument with the Accepted for Value stamp 

 Put the documents in the envelope to the Secretary and seal it. 

You should have one set of the documents remaining to keep for your records: 
 COPY of the BOE 
 COPY of the Letter of Advice 
 COPY of the charging instrument with the Accepted for Value stamp.  

Have your friend inspect the contents of the creditor’s envelope, seal it, fill in and sign the 
Certificate of Service (CoS).  You will keep the original CoS as a third party witness to the 
contents of the envelope.  After your friend has mailed the envelopes, have your friend return 
the PS 3800 receipt stubs.  Tape each round-stamped receipt to a separate sheet of 8.5” x 11” 
paper to keep with the signed CoS and your set of the documents copies.  When the two green 
cards (Form 3811) come back in the mail, tape them to the page with the appropriately 



 

numbered  Form 3800. 



 

h. Notice of Error 

The next page contains a sample Notice of Error (NoE).  The NoE CANNOT be sent with the 
original BOE and can only be sent out after the time has passed for ledgering.   

The NoE can be used in the following kinds of situations: 

 The creditor sends you some sort of letter indicating that they can’t accept your BOE. 

 The creditor sends you the next statement but it does not contain your BOE payment. 

You may need to use and customize the Notice of Error for a variety of circumstances such as: 

o you get a letter from the creditor stating they can’t process your discharging instrument,  

o the creditor’s statement you receive after sending the BOE does not reflect credit for 
your BOE. 

You will need to customize the sample letter in the following ways: 

 Replace the tag that says <date BOE mailed> with the date the BOE was mailed. 

 Replace the tag that says <date BOE received> with the date the BOE was received by 
the creditor. You can get this from the green Return Receipt card. 

 Replace the tag that says <date 2nd invoice received> with the date the most recent 
presentment was received. 

 Replace the tag that says <due date 1st invoice> with the due date on the invoice that 
was paid using the BOE. 

 Replace the tag that says <late fee amount> with the amount of late fee they charged 
on the 2nd invoice.  Delete this sentence if they didn’t charge you a late fee. 

 Replace the tag that says <interest amount> with amount of interest they charged you 
on the 2nd invoice.  Since you discharged the previous full balance, they should not have 
charged you any additional interest.  Delete this sentence if it does not apply to your 
situation. 

 Replace the tag that says <amount of 2nd invoice> with the total amount on the 2nd 
invoice. 

 Read the customized letter and make any other changes that are necessary to better fit 
your situation.  

You should send the notice of error using certified mail or you may want to use US Postal 
From 3817 (available on the US Postal Service web site).  The advantage of using PS Form 
3817 is that it is less expensive than using certified mail.  By using this form, the US Postal 
Service is acting as a third party witness that they will deliver the letter.  If the creditor argues 
that they never received it, they can take it up with the US Postal Service.  Type onto the Form 
3817 the words:  “Enclosed was “Notice of Error dated …..” 

We also suggest that you have a friend mail the letter and give you a Certificate of Service to 
prove what was in the envelope. You can use the sample Certificate of Service earlier in this 
file as a template. 

 



 

Individually,<true-name>, reserve all rights regarding common-law copyright of their respective trade-names/trademarks, <strawman>©  – as well as any and 

all derivatives and/or orthographic variations of said trade-names/trademarks, not excluding <true-name>.  Said Notice of Copyright is filed and recorded with 

<res-state>.  The filing of these copyrights and this publication constitutes public notice that: (1) Said Trade-names/trademarks or any derivative or 
orthographic variation of said trade-name/trademark, may neither be displayed, nor otherwise used in any manner, nor any use whatsoever of the common-law 

copyrights described therein, without the prior, express written consent and acknowledgment of Secured Party, <true-name> respectively, as signified by 

Secured Party’s original signature; (2) Secured Party neither grants, nor implies, nor otherwise gives consent for any unauthorized use of<strawman>©, and all 
such unauthorized use is strictly prohibited. 

<strawman>© 

<mail-street> 

<mail-city-st-zip> 

DATE:  <current date> 

<creditor-name> 

<creditor-street> 

<creditor-city-st-zip> Sent via Certified Mail # <enter certified mail number here> 

 

Re: Account #<creditor-acct-num> 
 

NOTICE OF ERROR 

and 

REQUEST FOR INVESTIGATION 
 

To Error Resolution Officer: 

On <date BOE mailed>, a Bonded Bill of Exchange (hereinafter, draft) was sent to you via Certified # <BOE-

num>; see Attachment 1.  This draft was in an amount sufficient to pay the full balance of my account.  This 

payment was received in your office on <date BOE received >.  On <date 2
nd

 invoice received>, I received another 

invoice that did not include credit for the instrument mailed on <BOE-num>.  The latest statement includes a late 

fee and an additional finance charge.  Since the draft should have settled the account in full and you received the 

payment before the due date of <due date 1
st
 invoice>, there should be no late fee or additional finance charges. 

This is my written Notice of Error under the Truth In Lending (12 CFR 226.13).  I am requesting clarification on 

the following issues:  

1. Why was the payment of $<discharge-amt> not posted to my account?  

2. Why was a late fee of $<late fee amount> charged when the last payment arrived by the due date? 

3. Why was additional interest of $<interest amount> charged when the last payment would have settled the 

account in full? 

As I understand the regulations (12 CFR 226.13(d)), I have the following rights:  

1. The statute gives the consumer the right to withhold a disputed amount and collection action is prohibited 

until the matter is resolved. At this point, the entire amount of the most recent invoice is being disputed, 

$<amount of 2
nd

 invoice>. 

2. Your credit card company is prohibited from issuing an adverse credit report to the credit reporting 

agencies while this matter is in dispute. 

It is my understanding that your company has 30 days from the day you receive this notice to provide me with a 

written response.  If you discover that an error has occurred, I will accept a statement that corrects the errors listed 

above as your response.  If you determine that no billing error occurred, I shall expect a written explanation why 

you reached such a conclusion.  

It always has been my intent to resolve this matter and to settle my account in full.  I look forward to receiving the 

results of your investigation in a timely manner. 
 

<strawman>© 

 

By: ________________________________ 

<true-name>, Secured Party 

 

enc: Certificate of Service



 

 

CERTIFICATE OF SERVICE 
 

 

On _____________________, on behalf of <true–name>, I mailed to: 

 

<creditor-name>.  

<creditor-street>  

<creditor-city-st-zip>  

 

the papers identified as: 

 

1. Bonded Bill of Exchange # <BOE-num> 

2. Letter of Advice 

3. Invoice <invoice-num> 

4. Statement of Account 

5. Copy of Certificate of Service 

 

by mailing them in a postage pre-paid envelope, addressed to the recipient named above, bearing Certified 

Mail # <BOE-num> for <true-name>, and obtaining a receipt from the Post Office clerk. 

 

My mailing location is: 

  

  

  

 

I am over the age of 18 and not a party to the transaction regarding the papers I mailed.  

 

 

Dated ________________________ 

 

___________________________________ _________________________________ 

Printed Name Signature 

 


